
 
 

 
 

 

 

 

CREST Cyber Olympiad (CCO) 

Sample Paper 
 

 

 

Grade Topic/Section No. of 

Questions 

Marks per 

Question 

Total 

Marks 

Grade 9 Computer & IT 40 1 40 

Achiever’s Section 10 2 20 

Grand Total  50  60 
 

The total duration of the exam is 60 minutes.  

 

Syllabus 
 

Section 1: Algorithms and Flowcharts in Programming, Visual Basic, Animations, HTML (Links, 

Anchors and Table tags), MS Word, MS Excel (Formula Auditing, Data Tools, Protecting and Sharing 

Workbooks/Worksheets, Working with Cell Range), MS PowerPoint, Hardware, Software, Input & 

Output Devices, Memory & Storage Devices, Flash CS6, Communication Technology (Networking, 

Internet and Multimedia), Operating Systems (Types-Interactive (GUI based), Real Time and 

Distributed, Commonly used OS), Windows, Latest Developments in the Field of IT. 

 

Achievers Section: Higher Order Thinking Questions - Syllabus as per Section 1. 

Questions are based on Windows 11 and MS Office 2016. 

 

For more details, visit https://www.crestolympiads.com/cyber-olympiad-cco 

 

 

Grade 9  

Pattern and Marking Scheme 

https://www.crestolympiads.com/cyber-olympiad-cco


 
 

 
Copyright © CREST Olympiads                                 1                               www.crestolympiads.com 

 

 

 

1. In MS Word, what will happen if you press the F8 key three times? 

 

a. A word is selected b. A sentence is selected 

c. A paragraph is selected d. A page is selected 

 

2. Which out of these options is designed to create a particular look in an animation? 

 

a. Template b. Presentation 

c. Slide d. Background 

 

3. Complete the sentence given below: 

In computer networking, cookies were originally designed for _____________. 

 

a. Client side programming 

b. Server side programming 

c. Both Client side programming and Server side programming 

d. Web side programming 

 

4. Which one of the following options is not an example of a utility program? 

 

a. Backup software b. Operating system 

c. Antivirus software d. All of the above are utility programs 

 

5. Look at the symbol given below. For which of the following purpose this symbol is used in 

Flowcharts? 

 

 

 

 

 

a. Terminal box - Start/End b. Input/Output 

c. Process/Instruction d. Decision 

 

6. In Visual Basic, which of the following control doesn't receive the focus and doesn't have a 

TabIndex property? 

 
a. Picture Box b. Tabcontrol Control 

c. List Box d. Label Control 

 
7. In Flowchart, diamond shaped symbol is used to represent which of the following options? 

 

a. Decision box b. Statement box 

c. Error box d. If-statement box 

 

8. Which of the following is a program capable of continually replicating with little or no user 

intervention? 

 

Computers & IT (Each Question is 1 Mark) 
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a. Virus b. Trojan Horses 

c. Rootkit d. Worms 

 

9. Analyse the images and answer the question given below: 

Which symbol is used for output/input? 

 

  

 

a.    

 

 

  

 

b.   

 

 

 

  

c.   

 

 

 

  

d.   

 

 

 

10. Fill in the blank: 

In Visual Basic, we can preserve the value of a local variable by making the variable ______. 

 

a. private b. public 

c. static d. implicit 

 

11. In Visual Basic, what do you call the process of hiding variable information in a class that 

doesn't need to be seen by the rest of the program? 

 

a. Hiding b. Encapsulation 

c. Protecting d. Covering 

 

12. Which is the last step that is done to verify whether the goals of the project are met? 

 

a. Checking b. Refining 

c. Scripting d. Deciding 

 

13. Which function in Excel is used to determine the day of the week for a date? 

 

a. DAY() b. WEEKDAY() 

c. WEEK() d. DAYOFWEEK() 

 

14. In Visual Basic, which one of the following indicates whether a particular condition is on or 

off? 

 

a. Check box b. List Box 

c. Combo box d. Function Box 

 

15. Bluetooth was developed by which of the following firm? 

  

 

a.    

 

  

 

b.   
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c.   

 

  

d.   

 

 

16. What is a character that is raised smaller below the base line called in MS Word? 

 

a. Outlined b. Inlined 

c. Superscript d. Subscript 

 

17. Shane is working on excel. She wants to add a pie chart in her sheet. Which of the following 

steps should she perform to open Chart Wizard? 

 

a. File > Chart b. Insert > Picture > Chart 

c. Insert > Chart d. Tools > Chart 

 

18. To put your logo on the same position on every slide automatically, which one should you 

use? 

 

  

 

a.   

 

   

 

 

 

 

  

b.   

 

 

     Handout Master         Notes Master 

 

 

 

 

  

c.   

 

  

 

 

 

 

 

  

d.   

  

 

 

 

 

 

 

 

19. Which out of the following you will not find in Paste Special Dialog Box in MS Excel? 

 

a. Add b. Subtract 

c. Divide d. SQRT 
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20. Fill in the blank: 

________ is the viewer of any sort of multimedia project that helps to control what and when 

the elements within it are delivered. 

 

a. Multiscreen multimedia b. Interactive multimedia 

c. Onscreen multimedia d. Portable multimedia 

 

21. In windows 11, which one of the following is the shortcut key to minimize all but not the active 

window? 

 

a. Win + Home b. Win + End 

c. Wind + D d. Ctrl + Home 

 

22. Out of the following, choose the operating system that will not allow you to run more than one 

program at once: 

 

  

 

a.    

 

 

 

  

b.   

 

 

 

  

c.   

 

 

 

  

d.   

 

 

 

23. What will the function given below return in MS Excel 2010? 

=MATCH(12,{10,13,30,40,60},1) 

 

a. 0 b. 1 

c. 2 d. 3 

 

24. In a worksheet in MS Excel, what is the shortcut key to hide the entire row? 

 

a. Ctrl + 2 b. Ctrl + 9 

c. Ctrl + N d. Ctrl + - 

 

25. What do we call a network whose elements may be separated by some distance? It usually 

involves two or more networks and dedicated high-speed telephone lines. 

 

a. LAN b. WAN 

c. URL d. Server 

 

26. Fill in the blank: 

A ________ is an agreement between the communication parties on how communication is to 

proceed. 

 

a. Path b. SLA 

c. Bond d. Protocol 
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27. Fill in the blank: 

A processor that collects the transmission from several communication media and send them 

over a single line that operates at a higher capacity is called _____. 

 

a. multiplexer b. bridge 

c. hub d. router 

 

28. Which of the following refers to dangerous programs that can be 'caught' on opening E-mail 

attachments and downloading software from the Internet? 

 

a. Utility b. Virus 

c. Honey Pot d. Spam 

 

29. All the following statements are true about variable names except one. Identify it: 

 

a. The first character of a variable name must be a letter 

b. They may include letters, numbers and underscore (_) 

c. There is no upper limit for the length of a variable name 

d. You cannot use a reserved word 

 

30. Which type of animation is best for developing characters that would showcase depth and 

realism? 

 

a. 3D animation b. 2D animation 

c. Vector d. Alpha 

 

31. Complete the sentence given below: 

In an SQL SELECT querying a single table, the asterisk (*) means that ________. 

 
a. all column of the table are to be returned 

b. all records meeting the full criteria are to be returned 

c. all records with even partial criteria met are to be returned 

d. all records of the table are to be returned 

 
32. Which of the following device takes data sent from one network device and forwards it to all 

devices on the network regardless of the intended recipient? 
 

a. DNS server b. Switch 

c. Hub d. Gateway 

 

33. Which one of the following provides the ability to query information from the database, to 

insert tuples into the database, delete tuples from the database and modify tuples in the 

database? 

 

a. DML (Data Manipulation Language) b. DDL (Data Definition Language) 

c. Query d. Relational Schema 

 

34. Sajal created a PowerPoint presentation on his Physics project which he wants to present to 

his class. Sajal wants to add some additional point (not present in the slides) to help him 
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remember what he wants to say in each slide. Which PowerPoint feature is best suited for this 

purpose? 

 

a. Master Slides b. Comments 

c. Notes d. Track Changes 

 

35. Which of the following statement is TRUE in context with MS Excel 2016? 

 

a. Excel does not support pie charts. 

b. Once a bar chart is inserted in an Excel sheet, the colour of its bars cannot be changed. 

c. Excel does not allow the editing of chart titles after insertion. 

d. Excel chart type can be modified even after the chart is inserted in excel. 

 

36. Fill in the blank: 

Someone who seeks to break the defence of a computer or a computer network for a variety 

of reasons such as profit, protest, information gathering or recreation is called a 

______________. 

 

a. breaker b. burglar 

c. intruder d. hacker 

 

37. Fill in the blank: 

Exchange of text messages and computer files over network either local network as LAN or 

over internet as WAN is called as __________. 

 

a. Chatting b. FTP 

c. Download d. TCP 

 

38. < SCRIPT > … < /SCRIPT > tag can be placed within which of the following HTML tag? 

 

a. Header  b. Body 

c. Header and Body d. Footer 

 

39. Which of the following tags are related to Table in HTML? 

 

a. < table > < row > < column > b. < table > < tr > < td > 

c. < table < head > < body > d. < table > < header > < footer > 

 

40. Which of the following is correct to change font face in Web Page using HTML? 

 

a. < font = "font name" > … < /font > b. < font name = "font name" > …< /font > 

c. < font face = "font name" > … < /font > d. Font Face cannot be changed using HTML 
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41. Which of the following is FALSE with reference to cell editing in MS Excel? 

 

a. Edit the cell by double clicking the cell where the content is located 

b. Select the cell and press the F2 function key on the keyboard to edit the content of the 

cell 

c. Select the cell, click on the formula bar and edit the content 

d. Click the cell and press the F5 function key on the keyboard to edit the content of the 

cell 

 

42. Observe the flowcharts given below and identify the one that is used to represent the main 

segments of the program: What is the value of the following MS Excel formula? 

=MOD(11,3) & 32/4/2 

 

a.   2,4 b.  3,4 

c.  4,5 d.  3,4 

 

43. Which was the first company that worked to mass-market a microcomputer and change it to a 

personal computer? 

 

  

 

a.    

 

 

 

  

b.   

 

 

 

  

c.   

 

 

 

  

d.   

 

 

44. Observe the images given below and identify the fastest transmission media among the 

following: 

 

  

 

a.    

 

 

 

  

b.   

 

 

 

  

c.   

 

 

 

  

d.   

 

 

 

45. Consider the following code segment: 

if (Y < 0) 

{X = -X: Y = - Y} ; Z = 0; 

while (Y > 0) 

Achiever’s Section (Each Question is 2 Marks) 
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{Z = Z + X : Y + Y - 1 ; } 

Assume that X, Y and Z are inter variables, and that X and Y have be initialised. Which of the 

following best describes what these code segment does? 

 

a. Sets Z to be the product X * Y b. Sets Z to be the sum X + Y 

c. Sets Z to be the absolute value of Y d. Sets to be value of Y 

 

46. Which of the following is the correct way of assigning value "centerscreen" for form's start 

position property? 

 

a. Startposition.Form_1 = Formstartposition.CenterScreen 

b. Form_1.Startposition = CenteScreen.FromStartPosition 

c. Form_1.StartPosition = FormStartPosition.CenterScreen 

d. Form_1.StartPosition = FormStartPosition.Location.CenterScreen 

 

47. Match the following MS PowerPoint components in Column A with their description in Column 

B: 

 

Column A Column B 

a.  Slide Design i.  are the dotted-line containers on slide layouts that hold 

such content as titles, body text, tables, charts, 

SmartArt graphics, pictures, clip art, videos, and 

sounds 

b.  Auto Content Wizard ii.  These are the templates for Microsoft Office and 

PowerPoint that you can use to enhance your 

presentations 

c.  Place Holder iii.  is a feature available in some programs, usually found 

on the left side of the window. It displays thumbnails of 

files or features available in the program 

d.  Slide Pane iv.  It leads you through a series of questions so you can 

choose the best layout for your presentation 

 

a. (a) - (ii), (b) - (iv), (c) - (i), (d) - (iii) b. (a) - (i), (b) - (iv), (c) - (ii), (d) - (iii) 

c. (a) - (iii), (b) - (i), (c) - (iv), (d) - (ii) d. (a) - (iv), (b) - (iii), (c) - (i), (d) - (ii) 

48. Match the following type of multimedia in Column A with their description in Column B: 

 

Column A Column B 

a.  Interactive Multimedia i.  In this, you can use images to link to your 

information and also bars and charts to make the 

viewer of the presentation understand more clearly 

b.  On-Screen Multimedia ii.  It is a portable consumer electronics device capable 

of storing and playing digital media such as audio, 

images, and video files 

c.  Portable Multimedia iii.  refers to products and services on digital computer-

based systems which respond to the user's actions 

by presenting content such as text, moving image, 

animation, video, audio, and video games 
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a. (a) - (i), (b) - (iii), (c) - (ii) b. (a) - (iii), (b) - (i), (c) - (ii) 

c. (a) - (ii), (b) - (iii), (c) - (i) d. (a) - (iii), (b) - (ii), (c) - (i) 

 

49. Identify the term with the help of the description given below: 

1. It is the maximum rate of data transfer across a given path 

2. This is computed by taking the number of bits - in a Gigabit network, that would be 1 

billion and dividing that by eight to determine the bytes 

3. It is the capacity of a wired or wireless network communications link to transmit the 

maximum amount of data from one point to another over a computer network or internet 

connection in a given amount of time, usually one second 

 

a. Network b. Bridge 

c. Bandwidth d. Access time 

 

50. Identify category of Operating System with the help of the description given below: 

1. It is an operating system that guarantees a certain capability within a specified time 
constraint 

2. It is an operating system intended to serve real-time applications that process data as it 
comes in, typically without buffer delays 

3. In this type of Operating System, the response is guaranteed within a specified timing 
constraint 

 

a. Mac Operating System b. Real Time Operating System 

c. Distributed Operating System d. Open Source Operating System 

 

Answer Key 
 

1.  b 2.  a 3.  b 4.  b 5.  a 6.  a 7.  a 

8.  a 9.  d 10.  c 11.  b 12.  a 13.  b 14.  a 

15.  b 16.  d 17.  c 18.  d 19.  d 20.  b 21.  a 

22.  d 23.  b 24.  b 25.  b 26.  d 27.  a 28.  b 

29.  c 30.  a 31.  a 32.  c 33.  a 34.  c 35.  d 

36.  d 37.  a 38.  c 39.  b 40.  c 41.  b 42.  a 

43.  a 44.  b 45.  c 46.  c 47.  a 48.  b 49.  c 

50.  b             
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